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New features in FAstFax 4.0





For people already using FAstFax, here’s what’s new:





Cover Pages and File Attachments. FAstFax 4.0 now allows you to access the WinFax PRO send screen so you can use WinFax PRO's Cover Pages and File Attachments. 





Date and Time Scheduling. FAstFax 4.0 now allows you to send your faxes immediately or schedule them for a later date and time. This is especially useful for taking advantage of the cheaper phone rates late at night.





Print Hard Copy. FAstFax 4.0 now allows you to "Fax & Print" with one keystroke. For example, it sets your fax driver, faxes your document, then re-sets your printer driver, and prints your document—all automatically, all with one keystroke.





"Sticky" Default Settings. FAstFax 4.0 now allows you to set your favorite default settings from within the FAstFax program itself. Whenever you change a setting, FAstFax remembers were you were so that you will be defaulted to that setting the next time your run the program. For example, if you always fax "current page," simply select it one time and FAstFax will always default to that choice.





Dialing Prefixes. FAstFax 4.0 now handles all of the following dialing prefixes automatically: Outside line access codes (for example "9"), Local area codes, Long distance access codes, Local long-distance access codes, and 800 prefix access codes.





Hidden Identifiers. FAstFax 4.0 now allows you to completely hide your "hidden identifiers" so you don't even have to see them on the screen. FAstFax will find the recipient's name and fax number even when you have hidden text "not showing."





Resolution Choice. FAstFax 4.0 now allows you to send "low resolution" or "standard" faxes for yet another way to save on long distance phone costs.





Enlarged Page Previewer. Although it's still just a thumbnail sketch, the page previewer in FAstFax 4.0 has been greatly enlarged to better see the pages you intend to fax.





WinFax Phonebook Access. FAstFax 4.0 now allows you to access the WinFax PRO phonebook—which means you can use FAstFax like any other "driver-switching" macro to zoom straight to the WinFax send screen and select the person from your phonebook you want to fax.





One Button Phonebook Entries. FAstFax 4.0 now allows you to add a person's name and fax number to the WinFax PRO phonebook without ever having to retype it. Just run FAstFax with the "Show WinFax Send Screen" on and hit the "Add to phonebook" button. That's it! The name and number are automatically entered into your WinFax Phonebook.








What is FAstFax?





FAstFax 4.0 is a powerful add-on program for Microsoft Word for Windows 6.0 and Delrina WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks) that will save you and your employees hours of time.





Here’s how:





FAstFax scans your document, finds the recipient’s name and fax number, and (using DDE) automatically passes it over to WinFax PRO—so you no longer have to keep TWO separate phonebooks. If you’re tired of typing a person’s name and fax number TWICE—once on the document and again in the WinFax Phonebook—you will love FAstFax.





FAstFax gives you a thumbnail page preview of your document—so you’ll always fax the correct pages and be able to check the final look and layout of your fax before sending it off.





FAstFax allows you to easily fax an entire document or just the current page—which is great for those quick 1 page faxes.





FAstFax automatically sets the fax driver and resets the printer driver for you—so you don’t have to think about driver settings again. And no more print jobs accidentally sent to the fax modem!





FAstFax allows you to "Fax & Print" with one keystroke. For example, it sets your fax driver, faxes your document, then re-sets your printer driver, and prints your document—all automatically, all with one keystroke.





FAstFax also handles all of the following dialing prefixes automatically: Outside line access codes (for example "9"), Local area codes, Long distance access codes, Local long-distance access codes, and 800 prefix access codes.





Other features include: Cover Pages, File Attachments, Date and Time Scheduling, WinFax Phonebook Access, Resolution Choice, One Button Phonebook Entries, and more!





FAstFax does all this in 2 keystrokes!





Before the creation of FAstFax, here’s how many keystrokes it took (and, incredibly, this was when the person’s name and fax number were already in your WinFax phonebook!):


Hit alt-file-print.


Hit the “printer” button to open the “printer setup” dialog box.


Select the WinFax driver.


Hit “Set as default printer.”


Hit OK.


Set the “page range.”


Hit OK.


In the WinFax phonebook, hit the “search” button.


Type the person’s name.


Hit OK.


Click on the person’s name in the phone list to get his name and fax number into the “To” and “Fax” fields. (Or, if the person isn’t already in your WinFax phonebook, manually type this information in.)


Click “send.”


Hit alt-file-print.


Hit the “printer” button to open the “printer setup” dialog box.


Select your printer driver.


Hit “Set as default printer.”


Hit OK.





Now, the steps with FAstFax...


Hit Alt-X and ENTER.


Go get a doughnut.





In fact, once you try FAstFax and see how much easier and faster it is, you’ll never want to fax the old way again.








Installation and Setup





To setup FAstFax, DOUBLE CLICK the "install button." The FAstFax Setup dialog box will appear. You can then pick the default settings of your choice, and create your own custom identifiers.





� MACROBUTTON FAstFaxInstall ��





Note: This setup is made to be run again and again, anytime you wish to choose different default settings or re-design your own custom identifiers.





Note: For FAstFax to install properly, all three files (FASTFAX.DOC, FASTFAX.DOT, and FASTFAX.BMP) must be in the same directory (for example C:\FASTFAX). This is because the install macro looks for FASTFAX.DOT and FASTFAX.BMP in the same directory that you open FASTFAX.DOC.





We recommend you create a directory called C:\FASTFAX to store all the FAstFax files. This way you can re-run the Install FAstFax macro any time in the future should you decide to change any of the defaults or re-design your own custom identifiers.





This is what the install macro does:


It copies the FAstFax macro into your NORMAL.DOT template so that it will be available globally.


It assigns the keyboard shortcut key of Alt-X to the FAstFax macro.


It adds FAstFax to the menu of your choice.





Note: It adds these settings to your NORMAL.DOT template. So you won't see these changes until you open a file based on the NORMAL.DOT template. This User's Guide is attached to the FASTFAX.DOT template.








FAstFax Identifiers: “To:” & “Fax:” or Whatever you want!





FAstFax searches for “To:” and “Fax:” (or any custom identifiers you create) to identify the recipient’s name and fax number. If FAstFax can’t find a “To:”, it will put you in the To: field and wait for you to enter the recipient’s name manually. If FAstFax can’t find a “Fax:”, it will put you in the Fax: field and wait for you to enter the fax number manually.





Because FAstFax scans the entire document, the “To:” and “Fax:” information can be anywhere in your fax. Normally, they will be on the fax cover page, or if you are faxing a one page letter, they will be on that. But the nice thing about FAstFax is that they don’t have to be. They can be anywhere. And in any order.





For example, they can be on the same line, like this:





				To: Woody Allen Fax: 555-555-5555





Or they can be reversed, like this:





				Fax: 555-555-5555 To: Woody Allen





Or they can be separated by tabs, like this:





				To: 				Woody Allen


				Fax:			555-555-5555





Or they can have leading text on the same line, like this:





				This message To: Woody Allen





Or they can have following text on the same line (as long as there is a tab or at least two spaces after the name or fax number), like this:





				To: Woody Allen  Date: January 20, 1995





In fact, FAstFax's search routines are so smart, it will even work with everything crammed together on one line, like this:





				To:Woody AllenFax:555-555-5555





Note: FAstFax always goes to the top of the document and searches down. So if you save many faxes in one file, order them the way you file paper files—i.e. the most recent first. This way FAstFax will always find the correct “To:” and “Fax:”.








The Big Tip: "Hidden Identifiers"





FAstFax's ability to find "hidden identifiers" gives you complete flexibility in designing your faxes to look exactly the way you want, while at the same time allowing FAstFax to find the recipient's name and fax number accurately. To understand how this works, please see the following 3 examples:





Example 1: Hiding the "To:" and/or "Fax:"





If you don't want the “To:” or “Fax:” to show up on your fax, you can make them “hidden identifiers” by selecting them and choosing Format>Font>Hidden text. FAstFax will still find the name and fax number, but the hidden “To:” or “Fax:” won’t show up on your fax.





For example, you might want to fax a one page letter containing the recipient’s name, address, and fax number—but in this case, you wouldn’t want the word “To:” to show up. Simply do it like this:





To: Jay Bonzi


396 17th St.


Paso Robles, CA  93446


Fax: 805-238-5798





Dear Jay,





I love FAstFax! Great work! Kudos!





(Note: there is a hidden “To:” before the name Jay Bonzi. If you cannot see this, hit Tools>Options>View>Nonprinting Characters>Hidden Text. Once you see it, and know it’s there, go ahead and hit File>Print Preview to see that it doesn’t show up when you print and/or fax.)





Example 2: Using Separate Cells





If you split “To:” and "Woody Allen" into separate cells, FAstFax has no way of knowing they are related.





To:�
Woody Allen�
�



But not to worry! If you prefer this two-cell method, you can easily make it work with hidden identifiers! Simply custom design a name identifier (into anything different than "To:". For example, I use "To>"). Then simply add that "To>" as a hidden identifier. Like this:





To:�
To> Woody Allen�
�



FAstFax will search for "To>" and find Woody Allen! (Notice, too, that my hidden identifier "To>" is in a tiny 8 point font so that it is nearly unnoticeable on the screen.)





If you use this method often, I recommend that you store the hidden identifiers "To>" and "Fax>" in Word's AutoCorrect (with "formatted text"). Then all you have to do is hit "t" space, and AutoCorrect will replace the "t" with the hidden "To>". Then simply type the recipient's name like you always do.





Or, here's an even better idea! Just put the hidden identifiers in your fax templates. Then, every new fax document you create will already have them typed in.





Example 3: Skipping over YOUR fax number





If you have a header with YOUR fax number in it, you will want FAstFax to skip over your fax number and find the recipient’s fax number. You could simply make your fax number identifier anything different—like “Fax” or “(Fax)” or “Fax #”, etc. Or, if you want to use the same identifier for both your fax number and the recipient’s fax number, you can simply use a hidden identifier (like "Fax>"). Example:





ABC Widget Co.


1225 Main St., Paso Robles, CA  93446


Phone: (805) 222-2222  Fax: (805) 444-4444





To: So-and-so.


Fax: Fax> 555-555-5555





Dear So-and-so,





I love your widgets! Great work! Kudos!





Or, another way is to simply add a hidden space between "Fax" and the ":" in your letterhead. FAstFax will then skip over your fax number and find the recipient's fax number because it is looking for "Fax:" not "Fax(space):". On the screen, your fax number identifier will look like this: "Fax :". But that hidden space won't print, so on the fax, it will look like this: "Fax:".





So you see, with FAstFax 4.0, you have complete flexibility in designing your faxes to look exactly the way you want, while at the same time allowing FAstFax to find the recipient's name and fax number accurately.








Date and Time Scheduling





FAstFax allows you to send your faxes immediately or schedule them for a later date and time. When you choose "Scheduled", you can set the faxes to go out at any date or time. This is especially useful for taking advantage of the cheaper phone rates late at night.





Many people love this feature, not so much for saving money by faxing late at night, but rather because it allows them to batch their faxes all at one time. If you hate waiting for one fax to be sent before you can start working on the next one, simply schedule your faxes to be sent some time later. FAstFax will queue up all your faxes in WinFax PRO's event list and let you get immediately back to work. Then, after you have written and queued up the last fax in the batch, you can call up WinFax PRO, highlight all the faxes, hit the "Reschedule" button, and fax them all off immediately. With this method, you can prepare a half dozen different faxes and then walk away from the computer while they are all being sent.





When you schedule, remember that WinFax PRO only accepts date and time in the following formats: Date: MM/DD/YY. Time: HH:MM:SS. This is not hard to remember, as FAstFax displays the correct formats for you in the date and time fields. Notice, too, that FAstFax always defaults to today's date at 11:00pm that night. This is because the lowest phone rates occur in most places between 11:00pm - 8:00am.








Dialing Prefixes





FAstFax handles the following dialing prefixes automatically:





Outside line access codes





If you need to dial a prefix to get an outside line (for example "9"), FAstFax will automatically add this prefix before each fax number. You can also include commas for necessary delays (each comma = 2 second delay).





Note: FAstFax will ALWAYS add the default dialing prefix to EVERY fax number. If you don't use a default dialing prefix, leave this option blank in the FAstFax setup.





Local area code





FAstFax automatically recognizes your local area code and avoids dialing it. If you travel, move, or your local area code changes for any other reason, simply enter your new area code in the FAstFax installation program, and FAstFax will take care of the rest.





Note: The following dialing prefixes (Local area code, Long distance access code, Local long-distance access codes, and 800 prefix access code) may not work in some countries because of non-standard number lengths. FAstFax looks for 7 digit numbers (for eample 238-5798) and 10 digit numbers (for example 805-238-5798) to determine when local and long distance access codes need to be added. FAstFax only tests numbers that are 7 or 10 digits long.





If you dial many 7 and 10 digit numbers that do not fall into the North American standard (i.e. 3 digit area code followed by 7 digit number), you can leave the local area code blank in your FAstFax setup, and this will make FAstFax avoid testing ALL numbers—including 7 and 10 digit numbers.





Long distance access code





FAstFax will add a long distance dialing prefix to numbers outside of your local area code (usually a "1"). Note: The telephone companies are now in the process of eliminating these long distance access codes. When this change occurs in your area, simply re-run the FAstFax installation program and remove the long distance prefix.





Local long-distance access codes





FAstFax will add a dialing prefix to numbers WITHIN your local area code that require a long distance access code (usually "1"). Sometimes referred to as "toll calls," FAstFax automatically handles all of these local long distance numbers. Note: The telephone companies are in the process of eliminating these codes, also.





800 prefix access code





FAstFax will also automatically add the dialing prefix required for 800 numbers (usually "1").





Not supported: International access and local country codes





Note: International access codes and local country codes are not supported by FAstFax at this time. However, these codes can be handled by using either of the following two methods:





1) Add them to the number on the fax. For example:





 		Fax: 011-805-238-5798





If you don't like the "011" to show up on your fax, here's a tip: Just as hidden text works nicely for hidden identifiers, the same principle can be applied to numbers, or even text, that you need to pass to WinFax PRO, but that you don't want to show up on the fax. For example:





 		Fax: 011805-238-5798





You won't see the international code "011" on the fax, but FAstFax will find it, enter it in the fax number field, and pass it over to WinFax PRO for dialing. (Note: You can even include comma delays if needed.)





2) Simply add them by hand in the FAstFax program's fax number field prior to faxing. To speed this, set the default cursor location to "fax number field" so you can quickly enter any necessary numbers and be on your way.








Suggestions





Loading WinFax PRO





The most efficient way to use WinFax PRO and FAstFax is to have WinFax PRO already loaded, because this way, when you run FAstFax, it will pop right up. But even if WinFax PRO is not already loaded, it's no big deal. It only adds one more keystroke.





When you run FAstFax without WinFax PRO already loaded, the following message appears: “The remote data (control) is not accessible. Do you want to start the application FAXMNG?” FAXMNG is the main WinFax PRO program (it stands for “Fax Manager”). This message is Delrina's way of saying, "Do you want to load WinFax PRO?" So simply hit "Yes"—it will quickly load WinFax PRO—and FAstFax will take it from there.





Note: If you get an error when answering "yes" to "Do you want to start the application FAXMNG?", it usually means that the directory in which you installed WinFax PRO (usually C:\WINFAX) is not in your path statement in your autoexec.bat file. It should already be there, as WinFax PRO adds it during its installation.





WinFax PRO's Preview/Annotate feature





If you’re a person who enjoys Delrina’s "Preview/Annotate" feature, FAstFax supports this. Simply set the “Preview/Annotate” feature to on, and FAstFax will allow you to preview/annotate prior to faxing.





Note: You might notice that the formatting of the FAstFax and WinFax page previewers do not exactly match. This is due to the fact that whenever you format a document using a different printer driver than the fax driver, you will get different page formatting since different printer drivers pass different formatting information to the application you are using. Because FAstFax allows you to leave your default driver set to your printer, and then automatically switches to your fax driver when you fax, the page formatting will vary slightly between the FAstFax and WinFax previewers.





If it's important for you to check the final look and layout of your fax before sending it off, we recommend you use the WinFax "Preview/Annotate" feature. What you see there is a graphical picture of your actual fax. This way you know exactly what is going to print out on the recipient's fax machine.





Intel CAS software users





An incompatibility appears to exist between WinFax PRO and Intel CAS software. If you delete pending faxes from the WinFax Event List, the .DCX files that the Intel CAS software creates somehow do not get deleted. So you must go to the directory in which these .DCX files are stored and delete them manually. If you forget to do this, and you have scheduled these faxes to go at a certain time, the CAS software will start sending them out (even though they were deleted from the WinFax Event list).





Assigning FAstFax to a toolbar button





If you’re a toolbar person, assign FAstFax to a toolbar button. The only reason we didn’t automatically install it on your toolbar is because monitors that run 640x480 don’t have any more room to add toolbar buttons.





Upgrade from WinFax Lite to WinFax PRO 3.0, 4.0 (or WinFax PRO for Networks)





FAstFax does not work with Delrina's WinFax Lite because WinFax Lite does not support DDE like WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks) does. Therefore, with WinFax Lite, FAstFax has nothing to "pass" the information to. If Delrina ever upgrades WinFax Lite to include DDE support, then FAstFax should work with it also. But until they do, only WinFax PRO 3.0, 4.0, and Networks users can take advantage of FAstFax's dynamic data exchange.





Print out this FAstFax 4.0 User's Guide





We've put everything we could think of into this FAstFax 4.0 User's Guide. All of the most common questions and answers, problems and solutions, tips and tricks, etc. You might find this manual easier to read and refer to in printed form. Or, speaking of tips, here's another one: Whenever you need to refer back to something you've read in this manual, the quickest way is to use Word's edit-find command (Alt-E-F) to search for information regarding your question.





Using PIMs and Contact Manager Software





The greatest benefit of FAstFax 4.0 is this: once you've entered a person's contact information into your database ONE TIME, you will never have to type it again.





You can now keep all of your names and fax numbers in a PIM, Contact Manager, or even the Word 6.0 database—and once entered, you will never have to re-type a person's name and fax number again, either in the WinFax phonebook, or on the fax itself. (Even PIMs and Contact Manager software that integrate with the WinFax Phonebook cannot give you this because you'll still find yourself having to type the person's name and fax number on every fax.)





With FAstFax, you can take advantage of Word 6.0's merge fields to automatically fill in the information for you. Simply place the identifier "To:" before the <<Full Name>> field, place "Fax:" before the <<Fax Number>> field, and when you press the "view merged data" button, you'll see the merge fields filled in with the recipient's name and fax number. Then, you can hit Alt-X to FAstFax the puppy away!





(Note: Due to a tiny bug in Word for Windows 6.0, the FAstFax page previewer shows empty merge fields as blank lines, even when the "Don't print blank lines when data fields are empty" choice is selected. This only occurs in the viewer. The fax itself is actually correct. Just use the WinFax "Preview/Annotate" feature to see exactly what will print out on the recipient's fax machine. And if the WinFax Preview/Annotate shows empty merge fields as blank lines, we've found that turning off "background printing" under printing options will correct this.)





PIMs like ECCO Professional and Lotus Organizer have "export" features that allow you to export just one data record to a comma field delimited text file. When that text file is chosen as the "data source" for any Word mail-merge document you create, you'll see all the information automatically filled in. Even for faxing just one person, this merge trick is the greatest thing going because it will fill in all the information for you.





Here's how it works. I use a PIM called ECCO Professional that contains all my communications information (phone, faxes, letters, e-mail). My WinFax PRO phonebook is empty. So is my CompuServe e-mail address book. With my system, I only have to type in a person's information ONE TIME. Then, after that, it's a piece of cake communicating with them via fax, letter, e-mail, etc.





Here's how to do it: Simply create "Windows Recorder" macros that will repeat the following two steps: 1)  From ECCO Professional (or Lotus Organizer, etc.) export the person's name field, fax number field, CompuServe address field, etc. to a comma field delimited text file, and 2) In Word, open one of your Word for Windows mail-merge templates (I have different ones depending on what kind of communication it is: Fax to Business address, Fax to Home address, Letter to Business address, Letter to Home address, New e-mail, E-mail reply, etc.).





That's it! Now each new document you open will have all the person's information already filled in! Name, address, fax number, etc.—it's all right there.





For example, to fax someone at their work address, I simply hit my "Fax to Business Address" macro, and 2 seconds later I am over in Word for Windows—needing only to type the body of the letter. Everything else is automatically filled in: My letterhead, the date, the recipient's name, the recipient's address, the recipient's fax number, the hidden identifier "To:" before the recipient's name, the "Fax:" before the recipient's fax number, and even my scanned signature down at the bottom of the page.





All I have to do is type the body of the letter and hit Alt-X to FAstFax that puppy away! The whole process has three steps:





Alt-1


Type body of letter


Alt-X





You can't get much more automated than that.





Even if you use a PIM that cannot export a single record, you could periodically export your entire database to a comma field delimited text file, and designate that merge file as the data source for all your fax templates. Then, when you open a new file, simply use Word's database features (i.e. the binocular button) to find the person's record, and within a few seconds, you will have a merge document that contains all the information needed: name, address, fax number, and any other data you choose—all of it already filled in!





I've had people tell me that the value of this information alone was worth registering for FAstFax.








Registration





FAstFax 4.0 is shareware. Unregistered evaluation copies can be distributed freely. However, licensed copies can be used only by registered users who have purchased a permanent license.





You are encouraged to use this program for 15 faxes prior to obtaining a permanent license. You may share the files FASTFAX.DOC, FASTFAX.DOT, and FASTFAX.BMP with anyone you choose as long as you do not change them. You may not share the registration key, which is supplied to licensed users only. If you choose to continue using the program and register, that registration key may be used only by the licensee specified in the original order for the license. Licenses are not transferable and may not be modified.





A single License permits you to use one copy of the FAstFax software on any single computer, provided the FAstFax software is in use on only one computer at any time. If you have multiple Licenses for FAstFax, then at any time you may have as many copies of FAstFax in use as you have Licenses.





INDIVIDUAL USE:


	SINGLE LICENSE for the use of FAstFax 4.0: $29





MULTIPLE USE:


	SITE LICENSE for the use of FAstFax 4.0:


2 to 9 computers�
$19 each�
�
10 to 24 computers�
$15 each�
�
25 to 49 computers�
$13 each�
�
50 to 99 computers�
$10 each�
�
100 to 199 computers�
$8 each�
�
200 to 500 computers�
$6 each�
�



To register FAstFax 4.0, send a check or money order (payable to: Jay Bonzi) for your total number of Licenses to:





				BONZI SoftWare


				396 17th Street


				Paso Robles, CA  93446





Or you can register quickly by Fax or E-mail, with a charge card (Visa, MasterCard, or Discover). Simply include the name as it appears on the card, the card number, and expiration date. Send to either:





				Fax: (805) 238-5798


				CompuServe: 72053,2227





When you register, we will send you a personal registration number that will end the trial period and turn your evaluation copy into a licensed version. So even if you register by mail, you may want to include your fax number or e-mail address to more quickly receive your registration number.





You will also be entered into our database of licensed users, and thus immediately notified of future versions and updates.








MergeFax 2.0





Also, let us know if our other product MergeFax 2.0 sounds like something you might be interested in. MergeFax 2.0 is a powerful new program that allows you to mail-merge group fax hundreds of PERSONALIZED faxes with Word for Windows 6.0 and WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks)—all with one simple keystroke.





You can now "touch" all of your customers at the stroke of a key, sending the latest pricing information, special offers, "Thank you" replies, and new product information. Or send customized graphs, charts, letters, and up-to-date sales information to all your sales agents in the field. Imagine this power in your company.





MergeFax is one of those rare programs that will save you and your employees hours of time. Plus, the date and time scheduling features alone will save you big bucks by allowing you to schedule your faxes late at night when the rates are dirt cheap.





Before the creation of MergeFax, the best you could do was "group fax" the same document to everyone. Ex: "Dear Customer, thank you for your interest in Ski Chalet products."





The power of MergeFax is that it allows you to use Word for Windows 6.0's awesome mail-merge features to group fax hundreds of faxes that are PERSONALIZED to each individual. Ex: "Dear Jim, thank you for your interest in our winter ski product line." "Dear Joe, thank you for your interest in our arrow ski downhill racers." Etc.





MergeFax-ing is as simple as these 2 steps:


1. Set up your mail-merge main document.


2. Hit Alt-M and START.





Here’s how it works:





MergeFax automatically merges each data record, scans the document to find the recipient’s name and fax number, and then (using DDE) passes this information over to WinFax PRO.





MergeFax queues up all the faxes in WinFax PRO's event list—either to be sent immediately or scheduled for a later date and time.





MergeFax automatically sets the fax driver and resets the printer driver for you—so you don’t have to fiddle with driver settings. You just hit Alt-M and Start, and MergeFax takes care of everything else.





MergeFax does all this in minutes! On a 486-66 machine, MergeFax queues up WinFax PRO's event list with 100 faxes in 5 minutes!








If you have any questions...





If you have any questions at all, feel free to fax me at 805-238-5798 any time, day or night. (Note: That's my home computer. And I work from 9:30am - 5:30pm Pacific time, so I’ll be able to fax you back that evening, or early the next morning. No matter what, I promise I’ll get back to you within 24 hrs.)





Or you can E-mail me on CompuServe at 72053,2227. I check my E-mailbox frequently, and if you're having problems, I'll get right back to you!








* * * * * * * * * * End of FAstFax User’s Guide * * * * * * * * * *





�






* * * * * License Agreement * * * * *





You are encouraged to use this program for 15 faxes prior to obtaining a permanent license. You may share the files FASTFAX.DOC, FASTFAX.DOT, and FASTFAX.BMP with anyone you choose as long as you do not change them. You may not share the registration key, which is supplied to licensed users only. If you choose to continue using the program and register, that registration key may be used only by the licensee specified in the original order for the license. Licenses are not transferable and may not be modified. A single License permits you to use one copy of the FAstFax software on any single computer, provided the FAstFax software is in use on only one computer at any time. If you have multiple Licenses for FAstFax, then at any time you may have as many copies of FAstFax in use as you have Licenses.





It is your responsibility to determine if the program will work reliably on your equipment and for your particular business environment. BONZI SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED. NEITHER BONZI SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF BONZI SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. IN NO EVENT SHALL BONZI SOFTWARE'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE BEARS ALL RISKS AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE. Some states do not allow the exclusion of the limit of liability for consequential or incidental damages, so the above limitation may not apply to you.





This agreement shall be governed by the laws of the State of California and shall inure to the benefit of BONZI SoftWare and any successors, administrators, heirs and assigns. Any action or proceeding brought by either party against the other arising out of or related to this agreement shall be brought only in a STATE or FEDERAL COURT of competent jurisdiction located in San Luis Obispo County, California. The parties hereby consent to in personam jurisdiction of said courts.








* * * * * Acknowlegements - Trademarks * * * * *





WORD FOR WINDOWS and Microsoft are registered trademarks of Microsoft Corporation.





WINFAX PRO and Delrina are trademarks of Delrina Technology Inc.





FASTFAX and MERGEFAX are trademarks of BONZI SoftWare.
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